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Penpower Technology Ltd.

Software User License Agreement

You are licensed to legally use this software program (“the Software”) by Penpower
Technology Ltd (“Penpower”) under this license agreement (“The Agreement”). If you do
not agree with any of the provisions in this Agreement, please do not install, copy or use the
Software. By using the Software, you are deemed to fully understand and accept the provi-
sions of this Agreement.

1. Intellectual Property
All intellectual property rights in the Software, together with all information and docu-
ments included in the packaging for the Software (including but not limited to copy-
rights), are property of Penpower, and are protected by relevant laws and regulations.

2. License to Use
You are authorized to use the Software on one (1) single computer only. You may not use
the Software on any other machines other than the said single computer.

3. Authority to Copy
The Software and all documents included with the Software, and copyright thereof, are
property of Penpower. You are licensed to make one (1) copy of the Software for your
personal backup purposes. All other acts of copying are strictly prohibited.

You may not sell, lease, dissemble, reverse engineer, copy, translate, adapt or derive the
Software, or obtain the source code of the Software by any other means. You may not use
the Software for any purposes other than those permitted under this Agreement.

4. Business Users
If you need to install or use the Software on more than one (1) computer, please contact
Penpower or our local distributor to purchase a license for the additional use.

5. Liability
You agree to indemnify Penpower against all losses, costs, debts, settlement payments or
other expenses (including but not limited to attorneys fees) arising from your breach of
this Agreement, and you agree to compensate Penpower for all of the abovementioned
damages.

6. No Warranty
Effectiveness of a packaged software in handling information is closely related to its soft-
ware and hardware environment. The Software is published following careful develop-
ment and product testing by Penpower, but Penpower is not able to conduct tests based on
all possible combinations of software and hardware environment. Therefore, Penpower is
unable to promise nor warrant that there will be absolutely no risk of loss or damage of



information, or any other kind of loss, during installation and/or execution of the Soft-
ware. You must be fully aware of your risks in using the Software.

Penpower will provide you with the Software and support services in respect of the Soft-
ware to the maximum extent permitted by law. However, Penpower does not warrant that
the Software and information included in the package of the Software contain no defects
or errors. Penpower is not liable for any indirect, special or incidental loss arising from
the Software, including but not limited to loss of profits, damage to business reputation,
cessation of work, hardware malfunction or damage, or any other commercial damage or
loss arising from commercial use of the Software.

7. Limitation of Liability and Damages
The maximum amount of compensation payable by Penpower, in respect of any damage
incurred by you for any reason under this Agreement, is limited to the amount you have
already paid to Penpower in respect of the Software.

Under no circumstances will Penpower be held liable for the possibility of loss, notwith-
standing Penpower may be aware of the possibility of such loss.

8. Prohibition Against Sublicense
You are prohibited to assign the license in respect of the Software granted to you under
this Agreement, or to grant a sublicense to another person.

9. Jurisdiction
With regards to any disputes arising from this Agreement, Penpower and you agree that
the court having jurisdiction over the business location of Penpower will be the court in
the first instance.

10. Miscellaneous
In the event that any provision of this Agreement is found to be invalid at law, such
invalidity will not affect the validity of any other provisions, or the legal enforceability of
such other provisions.

In the event that the Software cannot be executed under conditions of normal use, due to
any damage to the original disk/s, Penpower will replace the disk/s free of charge.
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manufactured and/or packaged. If the content on your application screen differs from your
User Manual, please follow the latest application screen upon installation.
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Chapter 1 Product Introduction

The Penpower WorldCard provides you with a total business card management solu-
tion by integrating card recognition, management, transmission, and printing functions in a
single digitizing unit. So you can find your business cards at anytime and anywhere when
you need them.

1.1 WorldCard Serise

1.1.1 WorldCard Color

The A6-sized color business card scanner is supported by PENPOWER’s BCR technol-
ogy to ensure quick scan and accurate recognization of information on a color business card.
It provides 600 dpi resolution and can be used as an ordinary color scanner to scan 4x6 color
photos.

Picture Scan Button

Business Card Scan Button
Business Card Placement

Iip
* Business Card Placement: Insert card with the information side facing up, make sure
the card is placed against to the left-hand side with the mark.

* Business Card Scan Button: When running WorldCard software, press Business Card
Scan Button to open the Scan Wizard. Insert a business card and press Business Card
Scan Button again to scan it.

* Picture Scan Button: Open WorldCard software, press Picture Scan Button, insert a
picture to scan and save it in JPG file format.

Specification

¢ Dimensions: 175x75x45mm

* Weight: 216g
 Resolution: 600 dpi
* Interface: USB

* Image: Color

1-1
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1.1.2 WorldCard Office

The A8-sized gray-scale business card scanner is designed based on PENPOWER’s ker-
nel technology of character recognition. It ensures users can identify data on a business card,

input them to the corresponding field, and create files for management within 5 seconds.
With the WorldCard Office, manual key-in or card searching is not required and the manage-
ment of business cards is more efficient.

Scan Button
Busi Card Plac

Tips
* Business Card Placement: Insert card with the information side facing down, make
sure the card is placed against to the right- hand side with the mark.

* Scan Button: When running WorldCard software, press Scan Button to open the Scan
Wizard. Insert a business card and press Scan Button again to scan it.

Specification
e Dimensions:  106x53x27mm
» Weight: 73g
 Resolution: 600 dpi
* Interface: USB

* Image: Gray-scale
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1.1.3 WorldCard Ultra

The intelligent mailbox concept with indication light, guide you to scan business card in
the easiest way that you have never experienced.

Business Card Placement

Intuitive LED Indicator

Tips
* Business card placement: Insert card with the information side facing up.

« Intuitive LED indicator: LED indicator will blink when a card is inserted. It will blink
faster during scanning.

Specification
* Dimensions:  106x53x27mm
* Weight: 160g
* Resolution: 600 dpi
* Interface: USB

* Image: Color
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1.2 Product Feature
* Easy Card Reader

Scanning or capturing your business cards has never been quicker or easier.

* Organizing Business Cards
After scanning or capturing your business cards, WorldCard software allows you to orga-
nize, sort, search, add and delete any entries. Also, you can easily edit and add comments
to any business card.

* Advanced Search

Full text search to find your contacts easily and conveniently.

* Support multi-language
Recognize business cards in different languages, including English, French, German,
Italian, Spanish, Dutch, Swedish, Norwegian, Danish, Finnish, Russian, Polish, Turkish,
Hungarian, Spanish(Spain and Mexico) Portuguese(Portugal and Brazil), Greek, Tradi-
tional Chinese, Simplified Chinese, Japanese, Korean and many more to come.

* Multiple Categories and Sub-Categories

Organize card information into categories and sub-categories in anyway you want.

* Print Templates

WorldCard provides various print templates. You can also easily create your own tem-
plates and print contact information in different formats.

* Recognize Contacts from Other Sources
Recognize business card image files taken by digital cameras or advanced mobile phones.
It can also work with the flatbed scanner.

* Data Exchange

Supports synchronization/importing/exporting for Outlook, Outlook Express, Lotus
Notes, Palm, Windows Mobile, ACT! by Sage, Goldmine, Salesforce and other PIM
software.

e Unicode

Unicode makes it possible to display various languages of business cards at the same
time.
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Chapter 2 Getting Started

2.1 System Requirements

* Pentium III 800 CPU or above

* 256MB of RAM

* 200MB of available hard disk space
» Windows 2000/XP/Vista

» USB Port

2.2 Installing Penpower WorldCard

To properly use your WorldCard
1. Install the software included on the CD.
2. Connect your WorldCard scanner to your PC.

3. Scan or capture your business cards and enjoy!

2.2.1 Software and Driver Installation

To save time, Penpower has combined the installation of the hardware and software into
one easy process. To start, insert the CD into your CD/DVD ROM (if the program does not
automatically start, just double-click the setup.exe file on the CD).

1. Click Next.
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2. Select I accept the terms of the license
agreement to accept the license agree- e
ment. Please read licensing agreement — Eeop et Teilogy]L

Software User License Agreement

completely. T
Penpower Technology Ltd (“Penpower”) under this license agreement
(“The Agreement”). Fyou do not agree with any of the provisions in this
| Agreement, please do not install, copy or use the Software. By using the
Software, you are deemed to fully understand and accept the provisions
of this Agreement.

1. Tntellectuel Property

Alotellectul p ts inthe Software, together vith all
i et e

< o> —

3. Please fill in your name and company
name. Click Next to continue.

<ok | New>

4. Please follow the instructions in the on-
screen notice. Click Next to continue.

5. Please select the location to install the
program. The default location is c:\Pro-
gram Files\WorldCard. Click Next to
continue.
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6. Click Install to begin installation.

7. If you want to run the Scan Manager
when starting up the computer for quick
scanning into Outlook, Outlook Express,
Windows Contacts or ACT! directly,
click I want to execute Scan Manager
when start-up, and then click Next to
continue.

8. Click Finish to complete installation. If
you do not want to restart now, click No,
I will restart my computer later.

fralls <ok | (i [ coma

2-3
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9. After installation, you can run the application software under [Start] /[All Programs]/
[PENPOWER WorldCard] / [WorldCard].

I scanizPDF 3

—/
* | ScanzPoF
- @ Penpower Chinese Expert 3

lg Paint

@ Penpower Chinese Expert Trial 3

WorldCard
@ Scan Manager
,-t_ Help
fsa Uninstall

J—
g
+y Start

10. System will ask you to register for warranty at your first run. Please press Register now
to start registration or press Register later to skip this procedure. You can register later
on from [Help]/[Register]. If you want to choose Register later and do not need to be
reminded again, you can check Don’t show this page at startup.

Regjster, reminder

Please register pour product at www.penpower. net/reg.himl to ensure wananty service,

Register now Fegister later

I Don't show this page at statup

2.2.2 Connecting Hardware

After installing the software, connect the USB connection of your WorldCard scanner or
business card camera to the USB port of your computer.

Note: Some computers may shut down accidentally after connection. This is due to lack of
power to support several USB devices. To avoid this problem, connect your World-
Card scanner/business card camera and other USB devices to an extra-powered
USB hub.

Windows 2000

Digital Signature Not Found x|

The Microsoft digital signature affims that software has
been tested with *indows and that the software has not
been alered since it was teste:

After connecting your device, the Digital
Signature Not Found dialog box displays
on your computer. Click Yes to complete
the hardware installation of the card scan-

The software you are about ko instal doss ot contain a
Microsoft digital signature. Therefore, there is no
guarantzs that this software works comectly with
Windows.

PenPower A8 Office

If you want to search for Micresoft digitally signed
softwae, visi the indows Lipdate Web site at
it /winclowsupdate. microsoft com to see if one is
avalable

ner.

Do you want to continus the installation?

Yes No More Info
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2.3 Preparation for Card Scan

2.3.1 Calibration Calibration ®

After lnStalllng the SOftW&I’C and dI‘lVCI'S, Please insert the calibration card and press "Calibration'!
your WorldCard scanner must be calibrated
in order to ensure perfect results.

Place the calibration card into the scan-
ner. Make sure the calibration card is flush
Wlth the mark to the side. ‘ CancslC)

Note: To calibrate the WorldCard Color and Office scanner, insert the blank side of the
card face down. To calibrate the WorldCard Ultra color scanner, insert the blank
side of the card face up. In case the calibration card is lost, you can use any same
size white card for calibration.

Tip: If there is any color indifference after scanning a card, you can calibrate the scanner
by clicking Calibration on the Tool menu.

2.3.2 Start-Up Wizard

Start your WorldCard software by double-clicking the WorldCard shortcut on your desk-
top. After the WorldCard program starts, the following screen will appear.
1. To start the wizard, click Next.

Welcome to WorldCard 6 X

. Welcome to WorldCard 6 'Wizard

PENPOWER

WorldCard

Wizard wil quide you to manage business cards

Click on Next to continue

¥ | would ke to keep the Wizard when start up.

| Neat Cancel

2-5
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2. The Wizard can help you quickly choose what you want to do:
Scan Card: allows you to add a card to your file.

Load Card Image: allows you to take an existing picture of a business card and add it to
your file.

Import data: allows you to import data from sources such as Lotus Notes, Microsoft Out-
look and Outlook Express, PocketPC, Palm, ACT! by Sage, Goldmine, Salesforce, etc.

Notes: The Windows Vista version does not support importing data from Windows Con-
tacts, Pocket PC and Goldmine.

Import Old Version Data: allows you to import the previous WorldCard file formats into
your new WorldCard File.

You can select a command and click Finish to continue.
Welcome to WorldCard 6 X

WorldCard vE provides scanning, managing. editing. piinting and other extended
funetions for business cards

 Scan card
" Load card image
 Import data

" Import old version data

Previous Finish Cancel
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2.4 Online Help

WorldCard provides excellent online help info:

1. Click [Help]/[Index] to find the user manual.

{W WorldCard efault.vck

FilefE) Edit{E)  Wiew(¥) Tool(T) Run(R) | Help(H)

Index
 Wizard Guide
Register
v Execute scan manager when start-up

1 About WorldCard
i I T~

2. Click [About WorldCard], you can go i X
to Penpower Technology Inc. official —_—
website at the left side to get more
information; the hardware information is
shown at the right side.

& revponer

Business Card Recogrition System

WorldCard

3. Also you can send e-mail to our customer
service contact by pressing Send Email
at the bottom. Or you can open your

. . . Penpower WorldCard V6.2 Eng - Hardware information
favorite email client, copy and paste 00000 07152003 S
hardware information and email to us. [CPU Ino]

Eenpower Techmology Ltd MD Athlon{tm] B4 Processor 3000+ 1

Al intellectual propeity rights in the [Memory Info]

Software. MemoryLoad : 40
Raminstalled : 1073201152
Memarybsailable ; 642785200
VitualMemary : 21473525676

Send Emal
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3.1 User Interface

W WorldCard - Default.wcf

File(E)

@ﬂﬁ.ﬁi‘

Edit(E)  wiew(y) Tool (I Run(R)  Help(H)

WorldCard

=
om

TBRER-G -39

= AllRecords 1282 Selected dat
=] Display Name: | company | office Tel Office E-mail

= allRecon (5 John Dow Karsten [510jBS7-6600 sales@penpower net
= CI Busibbs [ ALLENC.SOWERS  CCA House (F471532908333. a.comers@ccshouse.net
O fdwarker OJ Lawrence P. Bosquez  PERLINE (40913551424 iphosquez@perline.com
Elim] [ ‘Wal Taggart Innavative Home [454)494-1 1880260 phonenalt@innovativehame.cor
[ Flussell. Menk Flichard Inc. (215)51 34767 tussel menki@iichard com
[ LINDSAYJOHNSTON  Philadelphia (21512225678 lindsay@philadelphiz. com
O3 Frien [ ANTHONY BIsCONTI.__GROUP LTD (610)366-88811114  abisconli@paragonieg. com|
O3 urfil I Noelle M. Barbone ~ Welhlte (610)647-5600 nbarbone@weichertrealtors|
@ recydes [ MARKJ. LEUKUS  COLLEGE BOOKSTORE DIVISI... +1(800)877-120047... mleukus@dandh.com
[ Allan Hetkowski. CAE BOARD OF REALTORS. INC (570)587-1757 ahetkowski@gsbrhomes._cof
1 Mike Flynn Kinko's (610)328-7877 scc2B4@fedexkinkos.com|
. (5 ROSEMARY SCARDINA LEH\GHVAEASSDE\ATIDN OF (48418210501 tosemary@hvar.org

< >
Or\ngNe size I 1645.41 KB N Ey Hardvware comnected
D E F G I H J
A: Category tab F: Delete Category
B: Search tab G: Disk space used
C: Card Window H: Status
D: Recycle bin I: Alphabet

E: Add Category J: Connection status
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3.1.1 Menu Toolbar

AR

B
'

A: Save your Card file

B: Print Preview

C: Delete Card

D: Delete card from Category
E: Settings

F: Mode button

G: Scan a new business card

H: Multiple scan business cards

I: Add a new card from another picture
source

3.1.2 Alphabet

When the Alphabet index has contents,
the index letter appears in black.

The Alphabet index is indexed by
Display Name or Company. To select
it, on the Tool menu point to Setting and
click Field Setting. In the Alphabet Index
settings area you can choose by Display
Name or Company.

Tool (1) | RUNE)  Help(tD

Calibrate Scanner

Unmerge

Setting Export Option

Szan Option

o (0“ =
vy
L M

—14—@

t

=<+ [4
2<—E%

J: Synchronize with Outlook/PDA/Palm/
Lotus notes

K: Send an email to selected person

L: Export all your data and the portable
software to selected flash disk or
hard drive

M: Edit Card
N: Edit Print Template

Ewpot  Synchionize  FiekdDissley | UserDefned Field  Scan |
Avalable Fisd Displaped Field
Brviversary = Dieply Name
Biinday - Compary
Blood Type Oifce Tel
Calzgen) Oifice E v widh
Cricien Depainent
Compary. 2 Posiion
Compary_3 Oifice Address Crzels
Deperimen_2 d Oifce Fe
cpaenl_ Vicbie Algrmert
Display Narme 2 Oifce Web Sie
Display Name_3 @
dicaiion
Fist Name
Fist Name_2 -
Fist Name 3
Home Address
cme Addiess_2 -
Home Address”3
Heme Emai v

Alphabet indes settings

&5 by Display Name

€ by Company

‘ | Ok | Cancel ‘

When select by Display Name, the contacts will be indexed by display name. When
select by Company, the contacts will be indexed by company name. If the display name or
company name is not English, the contact will be put in =4,
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3.2 Scanning Business Cards

3.2.1 Scanning Directly

To scan your business card, insert the card into your WorldCard Scanner, placing the
card edge flush with the marker. The scanner scans the card immediately. The recognition
result saves to the system.

Note: Insert the business card face up into the WorldCard Color and Ultra scanner. Insert
the business card face down into the WorldCard Office scanner. WorldCard Color
scanner has two hardware buttons. The one on the top is for scanning pictures via
the TWAIN interface, another one is for scanning business cards.

Tip: After scanning business cards, please check the recognition results by Editing func-
tion for ensuring the accuracy.

Tip: Click the Setting arrow % |- and click Scan Option, or click Tool/Setting/Scan
Opting 7o set the recognition language. Refer to Chapter 5.10.5 for more detailed
explanation.

3.2.2 Scan Wizard
To scan business cards, select Scan ™ . The wizard opens:

Scan Wizard X

Front Side
| Back Side | Card Style: Front Side Back Sids

Chinese A |[parish ~
O Ssingle Darish = | |putch -
sided Duich English B
Firrish
® Double Finrish
e French ¥ | [Geman ]

Scan Status
Scanner: Connected
Paper. Card cannol be detected

Tip: Plesse insett the font side:

Scaner Panel

I~ Auto scanning

Calibration

¥ uto recogrition sfter scanning

™ Ediing business card ahter
scaming -

Clase

1. Under Card Style, select Single-sided or Double-sided.

2. Select the language of the card. If the card is double-sided select the language of the both
sides.

3. Insert the card into your WorldCard Scanner, placing the card edge flush with the marker.
Once inserted, the Scanner status area should say Ready.
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4. In the Scanner Panel area select:

- Auto Scanning if you want the scan to automatically start when the paper is inserted.

- Auto Recognition after scanning if you want the card information to be automatically
added to your file. If you want to preview the scanned card image before recognition,
do not select this. If you select Double-sided, you can click Skip back side to scan
the front side only.

- Editing business card after scanning to display the Edit window when closing the Scan
Wizard.

5. After you recognize the card, the information will automatically go into the Unfiled
category.

3.2.3 Batch Scanning

Please selct cad sy and langusge

To batch-scan business cards, select
Batch Scan = from the toolbar.

Card e
 Singlided © Doublosided

With this command, you can scan many
cards easily, preview them, and then add
them to your Card File.

1. Select single- or double-sided. Next,
select the languages of each side. —

Batch Scan Wizard (3]

Note: only cards (single-sided or double -

sided) that have the same languages .
chosen for each card can be batch- [ ———
scanned.

2. The Scan status pane displays the status
of the scanner. Select Auto scanning if
you want to automatically feed in your
cards. If the card does not scan properly,

click Rescan to try again. If you want

to return to the previous screen, click B ®
Previous.

Press "Recogniz” butonto stat

3. This screen allows you to quickly rec-

Recogriion progiess

p—
e G

Lot Tine.

ognize all the cards scanned during this ?g
i

batch. When you are done, click Finish. :
8

!

Previoust?) | [[Recogriestf) | CancellC)
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3.4 Viewing Contacts

WorldCard provides several ways to view your contacts: List mode, Label mode, Im-
age mode and Dual Mode. The default setting is List mode. To select other modes, on the
View menu click View Mode or click the Mode arrow from the toolbar.

3.4.1 List Mode View
List Mode is the default mode view.

(W WorldCard - V61.EN.wcf.

File(E)  Edi(E)  Wiew(y) Tool (I RunfR)  HelptH)
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WorldCard
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O3 Family P Lii MintsResearch (HK] Ltd, 23909532 tetsuo-set
B D Frisnds E 4| O Masstoduski  Electronic Systems and De. +81(04B0)761-21377 araki@ig
5] & 3 MATTHEW | .. Léw/ OFFICES OF AN KOO(408)4525338
O3 Eurep W Mic 3 -
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[ StevenHuang  Micrasoft Hong Kong Limited (B52804-420788
[ Toshiski Take.. WA CO., LTD [0480727-678
ﬁﬂ i v
< >
Criginal file size 320791 KB By Hardware connected

Contact Information List

After scanning business cards, you will see the scanned contact information list in the
right pane of the card window.

At the top of the pane, you can quickly see how many cards are in each category. For
easy organization, notice the dark-highlighted entries indicate cards that have not been
edited or verified yet.

To sort the contact information into alphabetical order, click the field name.
Besides the contact information, you can also quickly discriminate the single [] and
double sided card |ﬁ| by their different icons.

Tip: You may select the displayed fields from the Tool menu, point to Setting and click
Field Setting.
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Category tab

You can manage your business cards by storing them in category groups. The Category

tab is in the left pane of the card window. You can find the All Records category and the

Unfiled category as the default. WorldCard allows you to add as many user-specified catego-

ries and sub-categories to manage your business cards as you choose.

3.4.2 Label Mode View

The Label Mode view displays contact information and business card at the same time.

The contact information shows display name, company, title, office address, mobile

phone number @ , office telephone number , office fax number e{}

website.

W WorldCard - Default.wcf

Fle(®) EdHE) Wiewy) Tool(T) Run(®) Help(H)
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WorldCard
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1 Unfiled &
3 Recycls Bin 18 (510)897-5600

L siojsar-eeos

sales@perpouer.net

W pEnpawer.net
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John DOW saies Section Manager

48520 Fremaont Bivd, Suite 610, Fremont, CA 84538
TEL: 510-897-8800  FAX: 510.887-6808

sales@penpower.net
ww panpowe net

Sales Section Manager

46520 Fremont Blvd, Sute 610, Freman...

®

18 (510)897-5600
£ sio)esr-ee0s

John Dow
‘Sales Section Manager

46520 Fremont Bivd, Sute 610, Fremont, CA 84538
TEL 510-897-6600  FAX: 510-897-6608
sales@penpower net

‘e Penpower.net

Original file size 1645.41 KB

By Hardware connected

This icon means the business card is double sided.

, Email address and
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3.4.3 Image mode
Click the button to view front side of all business cards, click the button
to view the back side of all business cards.

When the icon shows in the right-top corner, it means the contact has a double-sided
business card image. You can click the icon to see the other side of business card image.

W WorldCard - Default.wcf

Fle(E)  EdWE)  View(¥) Tool(D Run(R)  Help(H)

O3 Business @
O Coworker (
= [ Customer
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3.4.4 Dual mode

Dual mode lists the scanned contact information in the upper right management pane and
can display the front and back side image of the business card in the lower right pane. You
can click the front or back side icon of the card to magnify it.

When the icon shows in the right top corner, it means the contact has double-sided
business card image. You can click the icon to see the other side of business card image.

L WorldCard - Default.wef DEX
Flel) EdHE) view(y) Teol(D) Run(®) HelptH)

WorldCard

BB B B R -5 -3

B
&

&

= &llRecords ard

=1 | Display Narme Office Tel Office E-mail

E= AllRecords (51 net
= [J Business 3 John Dow Penpower_net (510)897-6600 sales@penpower_net
O Coworker [ Russell. Menk. Richard Inc. 2155138767 russell.menk @richard com
= O Customer O walt Taggart Innovative Home (484)434-1188H250 phonewalh@innovativehome. com
03 Asia q
0 usa D
O Friend
3 Unfiled

@ RecydeBin

John Dow saiss secten Manager
48520 Fremont Bive, Suite 610, Fremont, CA 84538
TEL 5108076600 FAX: 510-607-6608
sales@penpower et
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Tip: You can drag the business card image from the view modes (except List Mode) to
other applications such as Microsoft Word, Excel etc.

3.4.5 Hiding WorldCard Banner

To hind the WorldCard Banner, click View/WorldCard Banner. It can extend the man-
agement area.

View(\¥) m W WorldCard - Default.wcf
Fie®) EOHE) Vew® Tool(D Run® Hep)

Sort 3

" [re} = . | ) o

View Mode 3 B @ Y E-F R R85 29 X =N

Search v = e H

Category W] Dispey N [ Company Loffce el Office E-mal Depar
3 John Dow Penpower.net (510)897-6600 sales@penpower.net
O RussellJ. Menk. Richard Inc. (215)513-8767 russell. menk@richard.com

Index 3 O Wal Taggatt Innovative Home (484434-1188H250  phonewalt@innovativehome.com

w WorldCard Banner (5 John Dow Karsten (510)897-6600 sales@penpower.net

' Status Bar
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Chapter 4 Editing Cards

4.1 Editing Window Overview

The Editing window allows you to edit the information of individual business cards.

To select the Editing window, just double-click any card record in the list menu of the
management pane or click the Edit Selected Record button X on the Editing toolbar and
edit the selected records.

You may click a record and press CTRL or SHIFT key on your keyboard, and then click
another record for multiple selection.

4.2 Verifying Contacts

The Editing window allows you to verify the individual contact information for any
specific business card. When the editing window is open for a card, the following screen will
be presented containing information relevant to the card selected from the Management
window.

{W WorldCard - Default. wcf.

Fis(E) EdHE) View(®) Hel(t)

Sales Section Manager

Karsten

(5102897-6500
(510)897-8608

46520 Fremort Blvd Sute B10., Fremont, C4 84533

45520 Fremont Bivd, Suite B12, Fremont, CA 34538
Framont, CA 84535
275600

The Editing window may be used to edit any information on a business card and to
correct or update information as necessary for future changes of an individual contact. The
features and functions of this window are described below
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Note: You can double-click on the business card image to see a bigger image or back to
original view.

@ WorldCard - Defaultwei.

SO Vo) Bt

el Er0RETasm
Fou 0 EroRErens

5 Fenent Sl S 610, Femen, A 3453

2 G0t e Suke 612 Feron, CA 945
Section Manager

, Suite 610, Fremont, C.
FAX: 510-897-6606
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4.3 Editing Contacts

The WorldCard Editing window has three panes: the Card Information pane, the
Personal Information pane and the Notes pane. The Card Information pane displays all
relevant business card data that was retrieved from the card recognition. The Card Informa-
tion pane is shown in the following picture.

W WorldCard --- Default.wef.
Fle(E) EdHE) Vew(®) Help()

(510)897.6600

Card Information

46520 Fremont Blvel Suite 610., Femort, C4 34538 ‘ b

46520 Fremont Blvd, Sute 612, Fremon, C4 34538 e DYOW s e i
p

remort, CA 94535

Sute 610,
FAX: 5108078808
-

forigeaifis 2o 1645.91 KB pusinesscard s oaded B Fercware comedied

The information in the Card Information pane is categorized in fields such as Name,
Position, Company, Address, Telephone/Fax numbers, Email address and Web Site. Addi-
tional categories are also available.

The Personal Information pane displays personal information about your contact which
is not retrieved from your contacts business card.

The Notes pane stores/displays important data from your personal notes about your busi-
ness contacts.

Note: If, at any time during the editing mode, an incorrect action is selected, you can

ous content of the business card.

To exit the Editing window, right-click the Exit button L'ﬁ or select Exit from the File
menu of the Editing window toolbar.

4-3
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4.3.1 Recognizing Partial Content of a Card Entry

In some cases, the information of a business card may not be completely recognized. You
may use the Partially Select and Recognize command of the Editing window. To select

Partially Select and Recognize, click this icon .

After clicking the Partially Select and Recognize, you can use the mouse to select the
specific area that contains the correct data.

After selecting the area, select the appropriate field for the information which has been
highlighted.

Besides, WorldCard allows you partial replacement to the filed you want to replace at the
left pane directly. Click the field you want to replace, select the area in the name card image,
then click Replace current field. The replacement will be done.

W WorldCard --- Default.wcf

Fie() EdHE) View(s) HelpiHh

WorldCard
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John Do
Fasition Gales Section Managed
Company Karsten
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4.3.2 Adjusting the Separation Rate
The Separation Rate is the rate of separation between the color of the card background

and the color of the text data contained on the business card.
After clicking the Separation Rate button =|, the following window appears.

(® WorldCard -—- Default.wef,
Fie®) EdE) Vew(d) Hep(t)

Sales Section Manager

Karsten

(510)857-6600
(510)897-6608

Address
48520 Fremont Bivd Suite 610. Fremont, CA 34538

48520 Fremont Bivd, Suit 612, Femont, CA 94538

[ Herdware connected

164541 K8 Business card s loaded.
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You can move the slider to achieve the clearest contrast between the background colors

of the business card and the text on the card. This adjustment is useful when the business
card image is blurred, or the contrast between the text and the background of the card is not
sufficient for correct recognition of the card information.

You may also adjust the separation rate by area. On the top business card image, select
a specific area, and move the slider to achieve the clearest contrast between the background
and text of the selected area. You can adjust multiple areas, each area with its own separation
rate. Click the EZ¥ button to remove selected area. Click the [[fl] button to reverse selected
area.

4.3.3 Deframing Command SEE = (W5 ot = =

The Deframing Manually command
allows you to select a specific area of a busi-
ness card to save. After the appropriate area
is selected, a box will be drawn around the
selected data.

If the data selected to be modified is cor- BerldCand
rect, click Yes in the dialog box. oo e tomedty?

Mo
CA94538

TEL 510-887-8800  FAX: 510-807-8608
sales@penpower net

be changed to white. o ereer

The data outside of the selection box will

4.3.4 Fine Rotate SR =L D

&ngle |00 |

The Fine Rotate command &4 is used
to correct the horizontal positioning of a
card after it has been scanned. This is some-

times necessary if a card has been inserted
into the WorldCard scanner incorrectly and
the resulting scan is skewed in the horizon- L

4

John DOW sjies Secion Manager
RS20 Fremont Elve Suite 610, Frer
TEL 510-807-66; FAX: 510-B97-8808

sales @ipanpowef net
i, penpower. npt

tal plane. An indication of a card that has
been improperly scanned is as follows:
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4.3.5 Rotating Card

If the card image shows an incorrect ori-
entation, you can use the Rotate Card com-
mand of the WorldCard editor to properly
align the card orientation. To use the Rotate
Card command, click the Rotate Card but-
ton [eid in the Editor window. After you

click the button , the rotation angle
options will appear.

Select the appropriate angle of rotation
and then click the Rotate button . The
card image will then rotate to the selected
orientation. Should you need additional fine
adjustment of the card image, click the Fine

Rotate button required.

4.3.6 Rescanning Card

If a card is scanned inappropriately,
you may use the Rescanning command
of the WorldCard editor by clicking the
Rescanning button . After clicking the
Rescanning button, the following menu ap-
pears.

You can select the appropriate languages
from the pulldown menus.

After you have selected the appropriate
language settings, you can click the Scan
Lsean. icon to rescan the business card.

The card must then be inserted into the
WorldCard scanner as appropriate for the
orientation of the languages selected.

I Y SENEI )

£
JOhN DOW sales Sacton Manager
48520 Fremont Blvd, Sute 810, Framont, CA 94535
TEL 5108876600 FAX: 510-897-6608

sales@penpower net
wiw penpowar. et

\/
The rotation angle is selectable
from a pulldown menu.

John DOW zalec Sacicn manager

48520 Frement Blvd, Suite 610, Framont, CA 94535
TEL: 5108678800  FAX: 510-807-8808
salesgpanpower.net

Wt perpawer net

WorldCard X

Are you sure to clear the current information of Fronk side and scan the card again?

Yes Mo

4-7
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4.3.7 Recognize Again

After adjusting a card image with any
commands of the Editing window, you can
recognize the business card again to update
the image processing of your revised card
image.

This task can be accomplished by click-

ing the Recognize again icon from the

Editing window. ‘ 7
Select the appropriate language(s) for Pt S S A, Pt CAMESS

TEL 5108876800  FAX: 510-897-8608

the front and/or back side of the card. Then, sesgoagan e
select the correct region for the language. -

You may use the Auto detection feature in the geographic region selection. If the card is
double-sided, select the Both Sides command to recognize each side. You may then proceed
with the Recognize again command by clicking the Recognize button __Fecognize ],

After clicking the Recognize icon is selected, the following prompt appears in the Edit-
ing window.

Click Yes to begin the recognition process. Note that the card information will be cleared
when you click Yes.

WorldCard

Aire you sure ko clear the current information of Front side and recognize the card again?

es Mo

4.3.8 Front and Back Business Card Image Exchange
Click to exchange the front side and back side images of the business card.
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4.4 Viewing Cards

Cards are displayed in the Editing window after the scanning process. The following
window shows a typical display of a card in the Editing window.

W WorldCard - Dafault.wef
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Karsten
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You can click Back Side button m to see the back side image of the busi-
ness card.

You can click E to select the different display percentage of the business card
image.

4.4.1 Saving Card Image

If the displayed card image is clear and the information legible, the card image can be
saved as a .jpg file by clicking the Save Card Image button ﬂ

4.4.2 Deleting Card Image

To delete a card image from the Editing window, click the Delete Card Image button
n with your mouse pointer.

If you have made an error in deleting a card image, the Editing window allows you to
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Chapter 5 Managing Business Cards

The management functions of WorldCard allow you to categorize contacts, send e-mail
by contact or group functions, add new cards to a group, import cards from other sources,
search cards by various data fields, encrypt files to protect your card database, print cards,
export the database to other applications and synchronize your card information with other
software applications.

5.1 Categorizing Cards

The WorldCard software allows you to manage your business cards by storing them in
the category groups. After installing your WorldCard software, you will find two default
categories on the management page: the All Records category and Unfiled category. You
can add as many user-specified categories and sub-categories as you choose to manage your
business cards.

5.1.1 Categorizing from Management Page

Each card, in addition to being categorized by last name, can also be categorized with our
own individual settings so that you can efficiently manage numerous cards in your World-
Card database. From the WorldCard Management pane, highlight the card information you
want to categorize, drag it directly into a specific category type under the Category list on
the left side of the management window.

o = All Records 13/13
Campany ‘ Office TEL 1 Cffice E-mail 1

[ ChungHua Lo Howard Communication Inc.  +886(4]265- 77777 hua@ms2. hoyard.com.bw
] Fi TECI G LT,

Lo

O Europ

O Family
= M Friends

tetsun-setoi@palm com

L]
L]
L]
0 oTw -
[l

Tip: Cards in each category can be easily moved from one category to another by drag-
ging.

Tip: Each card can belong to a main category and numerous sub-categories. For ex-
ample, Bruce is a vendor of your company and your classmate. You can drag his card
into vendor category and then, drag his card into the classmate category from the All
Records category. The first category you drag Bruce’s card to will become the main
category for his card entry.

5-1
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5.1.2 Categorizing from Editing Page

Card Category &3]
WorldCard allows you to categorize a DbiFecords

business card dir.ectly from the Editing . I:|T s Tobtan

pane. To categorize a card from the editing b eian

page, click on the Set Category & button e _ rtsieoeny_ |
The Card Category dialog box appears i

: gory g . 124 : Rename Category

Select the category and then click OK. You

may also add a subcategory from this win- Delte Categery

dow by clicking the Subcategory button.

oK

5.1.3 Sending Email by Category

To send email to a category group, select the appropriate category group from the man-
agement page. Once selected, the category will appear in the right pane of the Management
window.

To send email to the group, click the Email button ‘= . WordCard will add the email
addresses of the group members into your default email software. Also the Email editing

window will then open with the appropriate contact list.
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5.2 Merging and Separating Cards

WorldCard allows you to merge two business cards into one card entry. To merge two
cards into one, select two cards in the Management window.

On the Tool menu on the Editing window, click Merge and the following dialog box
appears.

Select the appropriate card as the front side of the merged card entry and press OK. This
action will merge the cards into one entry.

Merge data

Export
Card Preview

Edit Select One As Front Side
Delete Record
Mark a5 Ediad
Matk a5 Unadited

@& MichelWang

 FigE

oK Cancel

Send E-Mail »

Display map of Address b

Separating double-sided cards into two distinct card entries can also be accomplished
with WorldCard. To separate a double-sided card into two separate entries, select the ap-
propriate card from the Management window. Then, on the Tool menu click UnMerge. The
double-side card is separated into two separate entries in the appropriate category.

Export

Card Preview
Edit

Delete Record
Mark as Edited
Mark as Unedited
Set Category

Unierge

Send E-Mail »
Open Website
Display map of Address >

5-3
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5.3 Adding new Cards

You may add contacts to your WorldCard database by scanning their business card or by
manually entering the contact information. If you do not have a card from a new contact, you

can enter the contact information of a new business contact into your WorldCard database
manually.

5.3.1 Adding an Empty Card

To enter a contact manually without a business card, on the File menu in the Manage-
ment window, click New Empty Card. This will open the Editing window.

In the Editing window, manually select each category for your new contact. Then, type
your new contacts information into the field.

5.3.2 Adding the Same Company Card

WorldCard allows you to add contact information for a new colleague from a company
that is already in your database without scanning the actual business card. To add a new
colleague of a company already on file, in the Management window, select a card from the
new colleague’s company.

After you have selected the card of the new colleague’s coworker, on the File menu in the
Management window select the File New Same Company Card. This will open the Edit-
ing window.

W WorldCard - V61, EN.wef (=15

File(®)  Edb(E)  View(¥)  Help(H)

WorldCard

Kemel  Langu:

Cepmy [® Business Carcl Manageme.zit LTD

1o H 5720001 = -
oD N

Fax 5720002

Original file size 3715.37 KB By Hardware connected

On the left side of the Editing window, the new colleague’s company information will
appear in the Card Information pane of the Management window.
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5.4 Adding Cards from Other Resources

The WorldCard Business Card Scanner and other WorldCard recognition products are
equipped with a card scanner or camera which are used to capture a card image. However,
you may use other hardware resources in conjunction with your WorldCard software to pro-
cess card images.

5.4.1 Photo File

WorldCard can process a business card entry from a photo image in either .bmp or .jpg
format. To use this option of your WorldCard software, you must have a picture image of
the card on an accessible medium which your computer can access directly, as well as a con-
nected the camera or scanner. To select an alternative image source click the Image Source

icon % - and select the appropriate image source, either Photo File or Twain Scanner.

5.4.2 Twain Scanner

Card entries may also be uploaded through any TWAIN-compliant scanner. If your scan-
ner is connected, WorldCard software will recognize it and add the scanner to the resource

list. Click the Image Source arrow ™ - and click Twain Scanner.
Ensure that the resolution for your scanner is set to at least 300dpi.

Tip: You may scan up to 8 cards at one time with an A4 size flatbed scanner. Place the
card on the bed of your scanner with some separation between the card edges to
clearly distinguish each individual card. You may also use an A4-size white paper to
cover the business cards for recognizing regions of business cards properly.

When the scanning process is completed, the following TWAIN Scanner dialog box ap-
pears.

You can also recognize the cards automatically by clicking the Clear All Regions button
L} . This will remove all red recognition rectangles from your Twain Scanner window.

Then click the Auto Select Regions button %) . You will see the recognized cards identi-
fied as in the previous display of the TWAIN Scanner dialog box. Recognized cards will

appear within red rectangular boxes with their corresponding recognition number superim-
posed in red. Please see the following example of a correctly recognized card, (number 1)
and so on.

5-5
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WorldCard

Please adijust scanner resolution ko 300 dpi,

TWAIN Devices

PenPawer A6 Scanner

Twain Scanner

Cancel

‘P\ease select cads and click [Recognize].

Fit Image -

T

1
A

B Raesunn |

Language settings

Business card language IENQ‘iSh ~|

# oK I ’ Cancel |

e
N———

After the cards have been identified, click Recognize. In the Language settings dialog
box you can select the language to use to recognize the business cards. When the recogni-
tion process is completed, you will be returned to the Management window. Your new card

entries appear at the bottom of your All Records Category.
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5.5 Searching Contacts

You can quickly and efficiently find your contacts with WorldCard Search features.

5.5.1 Text Search

The Text Search command of the WorldCard software allows you to quickly find a
specific contact. To use Text Search in the WorldCard Management window, on the View
menu point to Search, and click Text Search.

The Text Search pane appears as follows:

Tip: You may enter the Text Search win- a 'K L
dow directly from the WorldCard ——m— e
Management window by clicking the _

Search button | @

In the Text Search pane, enter a key word or a group of key words separated by a

blank space in the Search box ‘ Search Keprord michel 'and click the Search button
—ceacilD . The Search pane will update, displaying the results as in the following picture.

In the left pane, there is a list of all categories where the data from your search string was
found. The right pane shows the search results that display all of the applicable fields for the
cards stored in your WorldCard database.

You can double-click on any record displayed in the Search Results pane to open the
card in the Editing window.

{W WorldCard --- V61.EN.wcf

FlefF)  EdEE)  Wiew(¥) Tool{T) Run(R] Help{H)

= - %

= Search Results

Eul | Display ... Compary Cffice TEL
[ Michel'wang  Eusistess Carltwmgement ... 5120001
@ Michel*wang  Business Carcl Manageme.... 5720007

e

Search Keyword michel

Original file size 3715.37 KB |Ei‘ Hardware connected
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5.5.2 Advanced Search

WorldCard also offers an advanced

search function. To use the advanced search Search
function, on the View menu, point to Search ch |
. Search Criteria
and click Advanced Search. e
The Advanced Search pane will open Cormpary -
and appear as right. Difiee TEL ™ s
o] and [C] ar
Tip: You may also open the Advanced O Select Categery
Search pane from the WorldCard
Management window by clicking o ie'“t[’am
—-—————w ram. ’—_l
the Search button | @ . When o ER
the Text Search pane appears, click D
on the Advanced Search + button +

fScarch |- |

In the Advanced Search pane, you can enter your search criteria by category. You may
select from categories in any one of three option windows. If you have several cards with
similar criteria in your database, you may narrow your search further by using more than one
of the Search Criteria menus.

After a Category for your Advanced

R Search Criteria
Search is selected from one or all three Dispaghame |~ Michel
Category options, you may enter an appro- Company o PI—
priate search string in the text field of each - .
. Oifice TEL 1 ~ Shinchu
Category. A completed search will appear.
O] and O ar

Please also note that the Search Criteria options include the AND operator < and and
the OR operator @ o . You may use these operators to further define your Advanced Search.
The AND operator defines that your search results contain the criteria listed in all three
search fields. Using the OR operator, a valid result must only match one of any of the three
fields to be a valid result.

You can further define your Advance Search Criteria by using a specified Category. To
select a specific category, select Select Category & Select Catenoy  and specify a category.

You may also define your Advanced Search by calendar dates. To define a period for an
Advanced Search by Dates, select Select Dates icon & Sek=ctDates and make date selection
available.



Chapter 5 Managing Business Cards

After selecting search by date, you may & Select Dates
use the From and To date options to specify Fram... 1/ 472006 -
a period for your search criteria. The From To.. 5/ 7/2006 -

and To options appear as in the right picture.

5.5.3 Finding Duplicate Data

Over a period of time, you may find that you have received a business card from the same
individual on more than one occasion.

WorldCard has a built-in feature for finding duplicate data. To use Finding Duplicate
Data, click Run on the Main Menu and then Duplicates Data. A progress meter briefly dis-
plays in the middle of the Management window showing the progress of the search. After
all records have been scanned, the Search Results pane displays the same name entries as

shown.

W WorldCard --- V61.EN.wcf

File(f) Edit{E}  wiew(y) Tool (T} RuniR)  HelptH)

WorldCard

Search Kepword

ched - |
[Category [ |

Unfiled

= Search Results
=8| Display ... * | Company Ffice TEL 1 (Qiffice E-1

(5 MichelWang  Business Carcl Manageme.... 5720001 michel @b
O Michel'wWang  Eusittess CarlMwmgement 5120001 ntichelEh

Original file size 371S.37 KB

= Hardware connected

In the pane on the left side, there is a list of all Categories where Duplicates Data was
found. In the Search Results pane on the right side, there is a list of all duplicate card en-

tries.
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5.6 Safeguarding Your Contacts

Information is a valuable resource to any business. WorldCard recognizes the intangible
value of your business card contacts and has built-in features to help you safeguard that data.

5.6.1 Save

WorldCard is a business card database management system. It automatically saves all
changes when exit the system. You can manually save your card database by on the File
menu click Save.

You can also save your database by clicking the Save button B on the WorldCard Man-
agement window.

5.6.2 Save As

You can save your database file to a specified directory for use as a backup file by using
Save as. On the File menu, click Save As.

WorldCard database files are stored in the .wcf format. No other format options are avail-
able. After you have named your file accordingly, click Save to complete this operation.

5.6.3 File Encryption

Protecting sensitive contact information is important in the business environment. The
WorldCard software recognizes the importance of sensitive data and allows you to protect
that data from unauthorized access.

To protect your WorldCard database from unauthorized access, WorldCard offers you an
automatic file encryption with password protection. You can encrypt your WorldCard data-
base by the following procedure.

On the File menu, click File encryption. File encryption X
The File encryption dialog box appears.

&+ UnUse file encryption

If you wish to use File encryption, ® Un(bamEm
select Use file encryption. 2
0ld password ’7
New password ’7

Check new password —

sppy | Ok Cancel
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With Use file encryption selected, you File encryption X
may use the File Encryption option with & Wil
password protection. & Use fle enciyplion
[¥ Set Pagsword # Change Password
When the Set Password/Change — E—
Password option is selected, the password — ——
option is available for you to enter your ap- Check new password —

propriate password options.

s | ok Cancel |

Note: Protect and safeguard your password. WorldCard does not offer a password recov-
ery option. If you forget your password, your database is inaccessible.

Tip: If you wish to decrypt the File encryption, place the mouse pointer over the selection
circle of the UnUse file encryption option.

5-11
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WorldCard

5.7 Online Map

WorldCard offers you online map with a click of your mouse.

1. Select the contact, then click Run /
Display map of Address. You can

select the country from the pull-down
menu.

rﬂﬁm

Note: WorldCard offer address searching of many nations, including: Australia, Austria,
Belgium, Brazil, Canada, China, Denmark, Finland, France, Germany, Italy, Ja-

pan, Netherlands, New Zeeland, Norway, Poland, Russia, Spain, Sweden, Switzer-
land, Taiwan, U.S., UK and many more to come.

2. You can also right-click on the contact,
then click Display map of Address.

Select the country from the pull-down
menu.

3. If address searching you selected is more

than one contact, the Display map of
Address menu will appear. Click on the

address you want search will lead you to

online map automatically.

(6 EE Vew Too(D) Run® Heb()

E
Cardprevien
e

Delete Recerd
Mark as Unedited
Set Category
e

unverge
3 Recyclebin <

eal
=
rﬁ] © o

Joraraiesze

sz B e tcmeis

Please click one address:

[1033 Baltery Stieet, nio. 204, Sul Frandsea, A
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5.8 Printing Cards

WorldCard software allows you to print card information in several usable formats. An
overview of the WorldCard printing features is presented in this chapter.

5.8.1 Printing Preview

Before printing card information, WorldCard allows you to preview your information in
the appropriate format for your desired output. To use the Print Preview options of your
WorldCard software, on the File menu click Print Preview. and the Print Preview pane
appears.

At the Print Preview pane, you can select several Print Preview Template Classes from
the Template Class menu to the left of the Print preview pane.

After the applicable Template is selected, you may further define your printing preview
by selecting the available options in the selected Template. A similar Print Preview option
list will appear depending on your selected Template Class.

When a Preview option has been selected, the Print Preview pane reflects that change
on the right side.

Phone Book.
Rotary Cards

WorldCard

[eddiess book prints a

address, phone nun
[phone rumber, email a

Letter 8" 11" (Full Page)
Franklin Day Planner 5 x 8.5
Day-Timer Sr. Desk
DyaRunner Running Mate
DayRunner Enterpreneur
DayRunner Classic

Avery 5.5x 8.5 #41-307
Label 7x 2

Origina il siz= 174.44K8 B Hardnare connec ted
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5.8.2 Editing Print Templates

WorldCard allows you to edit templates for printing your cards. On File menu click Print
Template Edit, the following pane appears. You may also click the Edit Print Template
icon Zg .

W WorldCard -—- Default.wcf

Fie(®)  Wiew(ts  Help(tD

5| @ <
Template Size Template Space
Addess Baok - Width = Fon =
erHame U ser Define - Height = Line =
Address book. pints a st with name, ]
ks, phone et bt moble Z000nm 2| Heign | 257.00nn>| QR
phorte number, emall adiess. homepage, etc
Row | Field =
200 Left 15.00mm-=]
200mn=]  Pight 1800mn={ & Pt Selecied Fegion & Pint Frame
o ]
H = L —
Display  [omios Tel  [omos Emen  [0fics Adress [Departmant [Faz[Gelection -
= oA PP =
isplay Name
[Company |
(Oiice Tel
fice £ mai
ment
[Positin
(Difice Address
e FAX
obie
[Oiice wieb Site
I < 3 LsstName v
origi e AlRE B Har

To edit the Print Template, you may select a Template Class and Template from the left
pane. Then adjust the settings of the print paper from the pane on the upper right. If you wish
to choose print fields, you can drag the field into the template editing area.

Note: WorldCard’s attentive categorizing function makes it flexible on Editing Print Tem-
plates, such as you can add City, Zip Code under Address column

WorldCard provides Add Label and

Add List template model for creating your DRI
Letter 8311 (Full Page) oG S

own templates. On the Template Class DapTmars ek e
DyaRunner Running Mate —

menu, click Edit. The Edit dialog box ap- Daumer Everprenewr___ AddList |

Avery 5.5 8.5 #41-307

pears. Label 71 o

To add a new print template, click Add
Label or Add List, and then enter the tem-
plate name. Click OK to return to the Print
Template Edit pane for editing the new
print template.

Note: You may also rename or delete templates with the Edit function.
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5.9 Exchanging Contacts

WorldCard software allows you to exchange valuable contact information with other ap-
plications through the use of the Import, Export and Synchronize commands.

5.9.1 Export

To select export fields, you may refer to 5.10.1 Export Option for a detailed explanation.
To export your WorldCard database to another application such as Microsoft Excel, Access,
Outlook, Outlook Express, Lotus Notes, PocketPC, Palm, ACT!, Goldmine, Salesforce, CSV
or VCard, on the File menu click Export.

This will open the WorldCard Export Wizard screen and the following dialog box ap-
pears. For the supported software, please refer 5.9.4 WorldCard Data Exchange Compat-
ibility List.

To use the Export Wizard, select the type
of application for the file type that you want to
create.

Export Wizard

Select application and press "Next” to continue:

Application

Tip1: Export Text File allows you to export all
fields.

Lotus Nates V6548
Micio ok

ok Express

el Contactsfy'3 », 4.x and Mobile 5.6)
Paim Desktoplvd. 1.2 or above]

S desforce

ACT! 2007 2008 [ Standard 7 Premium for Workgroups |
Geldrine V6,50

Micro:
Miciosoft Pocks
Tip 2: Export function supports on Excel 97,

Outlook 97 and Outlook Express 4.0 ver-
sion and higher.

Time & Chaos

CSY (Comma Separated Text Fie)
Image [Jpg]

Microsoft Access File

Mictasoit Excel

TestFile
Card File

worldCard FilefB.0 o later)

Tip 3: In exporting to an Excel file, WorldCard

transfers the different categories of con- T
tact information to different sheets.

Tip 4: Export Wizard will compress the file . It makes your filing and mailing easier by
producing a smaller file.

Warnning: Because of the compliance between unicode and ANSI code, you might export
unreadable characters to Palm Desktop, CSV or Vcard file in cases you exportChi-
nese, Japanese, Korean....from a single-byte language character based computer
(such like English, German, French and so on) to a double-byte language character
based computer (Such like Chinese, Japanese, Korean and so on).

Click Next. The next Export Wizard dialog box displays.

5-15
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Follow the instructions given in the
Export Wizard dialog box to select which

cards you want to export. And then click
Next.

If you have chosen to continue with the

Export function, choose the directory to export
the files to.

Click OK to export the cards.

To complete exporting the files, review the

information displayed in the Export Wizard
window.

After exporting is completed, click Finish
to close the Export Wizard dialog box.

Export Wizard

Select the card you want to expart and then press"Nest" to continue

Export Range
@ Al Cards
Al cards in the preview area

 Selocted Cards

Frevious Net | Cancel
Export Wizard 3]
Export As TentFiie
Selact diecton o expott
Fie Name
[C\Documerts
Browse
Previous o | Carcel
Export Wizard X
Expott s Teu Fle
Export sucosssuly. pease press "Finihi to et
Fie Name
C\Decunerts
| Fiish |

The Export Wizard operations for exporting your WorldCard database to all application
types are similar and will not be discussed individually in this manual. However, a brief
overview of the Export of a card to Microsoft Outlook will be presented.

To export a card to Microsoft Outlook, select a card or a group of card by selecting the
specific card(s) in the WorldCard Management window as shown in the following picture.
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(W WorldCard — Defanitwof

Fil:[E EdtE)  View®) Tool (D Run®)  Help(H)

Tew

Open

File encryption

Save N

Save s v@%v%vgv@“

I it
;;:’f = Al Recards 13413
[ER | pisplay Hame [ company. [ office TEL 1 [ Office F-mal 1
0 M

3y
Print Preview -
Print Template Edit [
1 Defanltswot «cl
Exit !

On the File menu, click Export. The Export Wizard dialog box appears, as previously
displayed in the section. Select the Microsoft Outlook application from the Application
pane in Export Wizard dialog box and click Next. The next step is displayed in the Export

Wizard dialog box.
Select Selected Cards in the Export Range. Click Next.

The following Export Wizard status dialog box appears.

Export Wizard Export Wizard

Expot to Microsolt Outiook

i Information
Al cads inthe preview aiza

i

Selectthe card you want to export and then press "Nest” to continue Status
Microsoh Ouook. WorldCard
o n T Detail
Expot Range Change ] ]
Deete [ [
il Carde

Theck WorldCad Frished
Check Microsoft Dullook. Fiished 14
(F Selected Cards Read WorldCerd, Firished 4

Previous Nest Cancel Aosept Exit

When the Export process is completed, you can view the Details page as shown in the

following picture by clicking Detail.

Display Mam First Nam Last Name Company Title L |
[ Add To Microsoft Dutiock Steven Huar Steven Huang Microsoft Hong Kong DEM Account M
& Add To Microsoft Outiook. JackieLai |Jackie Lai Businesscard Iid | Software RD En
[ £:dd To Microsnit Dutiook Toshiski Tak T oshiski Takehana Wi COL,LTD
B ad To Microsoft Outiok. GayTan  Gay Tan COMPLWARE
B Add To Microsait Outiook MATTHEW (M&TTHEY BERGER L DFFICES OF AIATTORNEY AT
& Add To Microsoft Dutiook Lii MintaResearch (HK) |PhD

v
L] >
Select all data
Select none data
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From the Details dialog box, you can choose to export all details of each card or none.
To close the Details dialog box, click OK. This will return you to the Export Wizard status

dialog box as seen previously in this section.

To complete the Export process, click Accept. You may see a suspicious script warning
message at this time. Click Continue on the warning dialog box to proceed. The Export
Wizard will now display the completed Status and Information of the exported cards being
processed.. To exit the Export Wizard, click Finish.

5.9.2 Import

To import data into your WorldCard
database from another application such as
Microsoft Outlook, Outlook Express, Pock-
etPC, Palm, ACT!, Goldmine, Salesforce,
CSV or VCard, click Import on the File
menu. The Import Wizard dialog box ap-
pears.

Select the type of application source to
import into your WorldCard database.

Note: The example displays import data
from Microsoft Outlook Express us-
ing Windows XP.

Click Next in the Import Wizard dialog
box. The next dialog box appears. For
the supported software, please refer 5.9.4
WorldCard Data Exchange Compatibility
List.

Note: When importing data from a Mi-
crosoft Office application such as
Microsoft Outlook, you may receive
a warning message to advise you
that a program is trying to access
email address information from the
application. This warning message
may appear similar to the following
picture depending on your version of
Microsoft Office. To continue, click
Yes.

Import Wizard

Select application and press "Next” to continue

Application

Lotus Notes VB.5v8
Microsoft Dutlack.

Microsaft Dutook Express

Microsoft PacketPC Contacts(y3. 4.« and Mobils 5.6)
Palm Desklop(4.1.2 or shove)

Sdestorce

|ACT! 2007 2008 | Standard / Premium for Workgroups )
Goldmine V6,50

Tire & Chaos
C5¥ (Comma Separaied Test File)
\/Card File

WeridCard Fie

Import Wizard

Impert from Microscft Outioak Express

Stalus

Micrasalt Oullook Express “worldCard

o 5 5 Detai
Change 0 []
Delete 0 []
Infermation
Check WerldCard, Firished 13
Check Miciosch Dutloak Express, Finished 17
Fiead Microsat Cutlook Express, Finished §
Accept Esit

Microsoft Office Outlook

/ A program is trying to access e-mail addresses you have
{ ! stored in Outlook. Do you want to allow this?

If this is unexpected, it may be a virus and you should
choose "No",

[ allow access For

Yes No Help
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While your files are being imported, a

blue progress bar displays. After the process Impot o Wirosalt Qutionk Express

is completed, the Import Wizard dialog st
. . Microsoft Outiook Express. WordCard
box displays Status and Information. o — . betl
Change a o
Delete a o 4

Information

Check WorldCard. Finished 13

Check Microsoft Outlook Express, Finished 17
Read Microsoft Oullook E spress, Finished 5

Aecept Esit

You can view the actual information being imported by clicking Detail. The Details
dialog box displays.

Details 3]
Display Man) First Nam4 Last Name Company Te ~
& Add To WordCard Dingingiing |jinging ding TRk B ST
& Add To WorldCard Frankie Char PENPOWER TECHH A De:
& Add To WorldCard TER &% T TR B ST
& Add To WorldCard Th h E3 BWDNG ‘YNvsHma HIIT
f 4dd To WorkdCard T3 3 x BEDNG YmSHAN H{mIET
v
< >
Select a data
oK
Select none data

In the Details dialog box, you can select to import all details of each card or none and
then click the OK.

To complete the Import process, click Accept. The Import Wizard dialog box will up-
date the Status and Information fields for the data accepted. When the update is completed,
click Finish to close the Import Wizard. You will find that your imported records have
been added to the bottom of the cards listed in All Records category.
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5.9.3 Sync

The WorldCard Synchronize function allows you to synchronize the data between
WorldCard and other applications such as Microsoft Outlook Express, Microsoft Outlook,
Lotus Notes, PocketPC Contacts, Palm Desktop, ACT! by Sage, Goldmine and Salesforce.

To use the Synchronize function, on the File menu, click Sync. The Syne Wizard dialog
box appears. For the supported software, please refer 5.9.4 WorldCard Data Exchange
Compatibility List.

Select the application that you desire to synchronize with your WorldCard database by
clicking Next. The Sync Wizard Status and Information dialog box will open. At the same
time WorldCard will begin to synchronize with the selected application.

Syne Microsoft Outiook
Seleet applisation and press "Next" to continue:

Status
Applcation

Micrasalt Outlook “worldCard

Lotus Notes V6 538
Microsoft Outiook Add El 14

Microsaft Dullook Express Change 0 [
Microslt PocketPC Contactsly3.x, 4.x and Mobile 5.5)
Palm Deskiop(V4.1.2 or above] Delets 0 [

Salesforce
ACTI 2007.2008 ( Standaid  Premium for Workgroups |
Goldmine VB.50

Information

Check WerldCard, Finished 13
Check Microsoft Dutlock, Finished 18
Read WorldCard. Firished 3

Read Mictosoft Outiook. Finished 14

oo

e = g

While synchronization occurs, a blue progress bar displays. Once the process is complet-
ed, the Sync Wizard window will display Status and Information data about the records
you have synchronize.

In the Status pane you can see that there is a difference between the Microsoft Outlook
database and the WorldCard database. The Information pane shows all actions that have
been completed at this point.

Note: The Sync function synchronizes the Client database with the Host database. In
other words, data in the Client database is changed to reflect the data in the Host
database. After clicking Accept, the Client database is to match the Host database.
After this point you cannot reverse the process. You may select the WorldCard
database to act as either the Host or Client database from the Settings dialog box
discussed in section 5.10.2 of this manual.

Note: You will be asked to input the User ID, Password and DB Path when you synchro-
nize with Salesforce to protect and safeguard your contact info.



Chapter 5 Managing Business Cards

You can view the complete details of the actions that will be taken to synchronize the two
databases from the Details dialog box. To view the Details dialog box, click Detail. The
Details dialog box appears.

Details 3]

Display Nam First Nam Last Name Company Title &

& Add To Microsaft Dutiook. Mikey Chiu | Mikey Chiu PPCTO Group Financs Yice Fie

& Add To Microsaft Dutinok. Steven Huar Steven Huang Microsoft Hong Kong OEM Account M

& Add To Microsoft Dutiook. Jackie Lai | Jackie Lai Businesscardhd | Software RD En

B Add To Microsoft Dutiook. Toshiaki Tak Toshiaki Takehana WA COL,LTD

o Add To Microsoft Outlook Gaw Tan  |Gaw Tan COMPUWARE

& Add To Microsoft Outiook. MATTHEW |MAT THEY BERGER Lew DFFICES OF AIATTORNEY AT

& Add To Microsoft Dutlook. Lil MintaResearch HK) | PhD

& Add To Microsoft Dutlook. Hichel Wang Michel Wang Eusixiess Carlbwmge Manager

& Add To Microsoft Outlook Michel wang Michel wang Business Carel Mana Manaaer ~

< >

Select all data
Select none data

From the Details dialog box, you can click Select all data to accept all data in the list as
acceptable changes.

For this item, the Sync function would DELETE the entry from Microsoft Outlook.
Alternatively, you can use the Select none data icon to clear the selection of all items in the
list. After reviewing the Detail list, you may close the Detail window by clicking OK.

To accept the actions required to synchronize the two databases, click Accept. The De-
tails dialog box will display the updated Status and Information panes. To close the dialog
box and complete the Sync process, click Finish.
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5.9.4 WorldCard Data Exchange Compatibility List

WorldCard is an intelligent gateway to your favorite contact managers or personal
information managers (PIMs). WorldCard supports synchronization, exporting, importing as
following.

WorldCard Synchronization

Maintain identical contact information in WorldCard and these software:

Item XP Vista 32 Vista 64

Lotus Notes v6.5-v7.02 v v \4
Microsoft Outlook v v %
Microsoft Outlook Express v

Microsoft Pocket PC Contacts (v3.x, v4.x and Mobile 5, 6) \s \s

Palm Desktop v4.1.2 or later v v v
Salesforce (Enterprise Edition/Unlimited Edition) v v v
ACT! 2007, 2008 (Standard/ Premium for Workgroups) v v
Goldmine v6.50 v

WorldCard Export

Export contact information from WorldCard to the following:

Item XP Vista 32 Vista 64

Lotus Notes v6.5-v7.02 \4 v v
Microsoft Outlook v v %
Microsoft Outlook Express v

Microsoft Pocket PC Contacts (v3.x, v4.x and Mobile 5, 6) v \

Palm Desktop v4.1.2 or later \4 v v
Salesforce (Enterprise Edition/Unlimited Edition) v \4 v
ACT! 2007, 2008 (Standard/ Premium for Workgroups) v v
Goldmine v6.50 %

Time & Chaos \4 v v
CSV (Comma Separated Text File) \4 v v
Image (JPEG) v v )
Microsoft Access File \ v v
Microsoft Excel \4 v v
Microsoft Windows Contacts v v
Text File v v v
vCard File v v v
WorldCard File (v6.0 or later) \4 v v
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WorldCard Import

Import contact data from the following products to WorldCard:

Item XP Vista 32 Vista 64

Lotus Notes v6.5-v7.02 \4 v \4
Microsoft Outlook \ v v
Microsoft Outlook Express v

Microsoft Pocket PC Contacts (v3.x, v4.x and Mobile 5, 6) v %

Palm Desktop v4.1.2 or later v \4 v
Salesforce (Enterprise Edition/Unlimited Edition) v v v
ACT! 2007, 2008 (Standard/ Premium for Workgroups) \4 v

Goldmine v6.50 v

Time & Chaos v v v
CSV (Comma Separated Text File) v v v
vCard File v v \%
WorldCard File (v6.0 or later) v v v
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5.10 Settings

WorldCard has many selectable Setting options to allow you to configure the operational
functions of Export, Synchronize, Field Display, User Define Field and Scan options. To
set your WorldCard options, use the procedures outlined in this chapter.

On the Tool menu, point to Setting and click any of the options. Alternatively, on the

main toolbar click the Setting button g .

5.10.1 Export Option

To configure the Export options, open
the Setting dialog box page as described in
the preceding section of this chapter.

The Setting Export dialog box displays
with ALL options selected as a default
configuration. The fields on the right will

be exported to Excel, Access and CSV files.

To add another field, select a field from the
left side and click the [->] button. Click
[>>] button to export all fields. You can set
the number of fields with the same name to
export (up to 10).

Select Split address field to export ad-
dress detail to different fields. After you’ve
selected the options you want, click OK to
accept the changes.

Ewott | Symhonge  Fell Dipley  Usei Defied Feld  Sem |

Please select export tems for exporting contens 1o Excel, Accessand CSV file

Home Addiess

Do b Count of export
ther Tel

Home Bl !

Home Web Sits
huldren,

Birthday
v Field order
oditied tine
sex Defined Fields |
sex Defined Ficlds 2 Tp
ser Deined Fields 3
ser Deined Fields &
e Deined Fields 5
sex Defined, Fields & Dowa.
ser Deined Fields 7
ser Deined Fields &
ser Defined Fields 0

e Tsld 1
7 Splitaddaess field
|8 cama




Chapter 5 Managing Business Cards

5.10.2 Synchronize Option

To set the Synchronize options, open
the Setting dialog box as described in the
preceding section of this chapter.

The Synchronize tab of the Setting
dialog box appears with Microsoft Outlook
as the selected PIM. PIM stands for Pro-
tocol Information Management software.
Change the PIM as desired. The Conflict
Process option can be set to manage any
conflicts which may occur during the Sync
operation.

ACT! and Goldmine require a user ID,
Password and DB Path. Before synchroniz-
ing with above applications, you may input
this information into the boxes in the Other
Options area.

Salesforce requires a user ID, Password
and Security Token. Before synchronizing
with above applications, you may input this
information into the boxes in the Other Op-
tions area.

Eqor  Symhonze |Felt Digply  UsstDefind Fell  Soam |

Select PIM Software.

Condliot Brocess (when both data changs)
O Moified data is displayed, plesse confirm it

Reglace previous data by recent data.
Reglace Microsaft Oullook by WordCard

Replace WordCard by Microsaft Outlook

© 0 ® o0

Igmore

Field Accordence
Tse "Field Accorfance” to chaose synchronization o xport
filds

Apply ok ‘ Cancel ‘

Setting

Evport  Sunchrorize IF\e\dD\sp\ay User Defined Feld  Capture |
Select PIM Software

[ACT! by Sage 2007 )

Confist Prosess (hen both data change)
Q  Modified data s displayed, please corfimit.

Replace previous data by recent data
Fieplace ACT! by Sage 2007 by WorldCard

Fieplacs WoldCard by ACT! by Sage 2007

0O 0 ® 0

Ignore

Field Accordance

Use Field Acoordance” ta chooss synchionization or export
fglds. g

Other Option

| Passward [

D8 Path | Browse
Apply ‘ 0k Cancel ‘
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5.10.3 Field Display

To set the Field Display options of the

List Mode, open the Setting dialog box as Bt Sychuonize PoldObvk | Lss Dot Son |
described in the preceding section of this s _—
chapter. S 3 Drtytins
el Bz vt wian

The Field Display tab of the Setting e 2 L | e
dialog box appears with a default configura- E%éﬁtg . Exb'iis‘ A‘fﬂm‘
tion as displayed in the above window. To E"m‘z .
modify the selected options, click any avail- Forei: .
able field from the Available Field menu et o
on the left side of the dialog box. After a AR e
field is selected, click Add to add it to the ::S?j
Displayed Field list. The selected field o] oo
will be added to the applicable WorldCard
screens.

To remove a field, click the desired field in the Displayed Field list. Then click Remove
to delete the field from your WorldCard screen views. You may also set field options from
the available options on the right side of the Field Display window. Once you have com-
pleted your changes, click Apply to apply any changes.

The Alphabet index can be indexed by Display Name and by Company. Please refer to
Chapter 3.1.

5.10.4 User Define Field

To configure the User Defined Field options, open the Setting dialog box as described in
the preceding section of this chapter.

Eigort  Sywhrorze FelDiply UssrDefaedFill | S |

The User Defined Field tab displays
the default configuration as seen in the
preceding picture. You may define up to
ten user-specified fields to be displayed in
your WorldCard screens. To define a field,
select a User Defined Field from the avail-
able fields on the left side of the dialog box.
Then, assign the Defined Field Name and
Define a Recognition Keyword in the text
box. Set the language recognition option
and click Apply.

User Defined Fields

UsexDefined Beld L Define Field Name ’Enn.ki
N Detine Recogniion
Defi R ST

(" Chinese, lapaness and Korean Recognition Kernel

(" English Recognition Kemel

& No-Recognition

Apply Ok Cancel
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5.10.5 Scan Option

To configure the Scan options, open the Setting dialog box as described in the preceding

section of this chapter.

The Scan tab displays the default con-
figuration as seen in the preceding picture.
You may define Card Style, Language,
Chinese character options and Scanning
method. Click Apply for the settings to take
effect.

Setting
Ewport  Synchorize  FildDisply  UserDefired Field  Sosn |

Cad Syle
O Single-iced ® Double-sided

Language
Frank Side Back Side
[Engish | [French |

Chinese character option
Output character [ Traditonsl Chines, | | Recognize Hong Kong characters

ok Cancel

5.10.6 Revising the Results of Chinese Card Recognition

WorldCard software has optical character
recognition (OCR) capabilities designed to
work specifically with Chinese characters.

To optimize the settings for recognition
of a Chinese language card, on the Scan
tab in the Chinese character option area,
select Traditional Chinese or Simplified
Chinese.

Expon  Synchiorize  Field Display  User Defined Field Sean |
Card Stle

O Single-sided ® Double-sided

Language
Front Side Back Side

Englsh | [French =]

Chinese character option

Ouiput character

Apply ‘ Ok Cancel |

Under the Chinese character option area, you can select Recognize Hong Kong
characters if you are scanning cards from Hong Kong. The character set for Hong Kong is
slightly different than the Traditional or Simplified Chinese character sets.
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5.11 WorldCard Portable Disk

With Penpower WorldCard, you have a new traveling companion and all the flexibility
you need for a successful business trip. You can quickly store your WorldCard Portable
software and database on any USB flash disk and access them from the USB port of any
available computer.

5.11.1 Saving Card Data to a Portable Disk

Note: WorldCard does not come with a flash disk. Flash disk must be purchased separate-
Iy.
To save your WorldCard database to a portable disk, at the Management window click
the Export to Flash Disk button %" . The Flash Disk dialog box displays.

In the Flash Disk dialog box, select an A ®
Export Range. Setting the range to the Se- B
lected Cards option exports only the cards
that have been selected in the Management
window.

@ Al Cards
£ Al cocs it preview e
" Selected Cards
After you have set the Export Range,
select a Flash Disk drive from the Select sokeDikh [CiCard MimiDbd <
Drive list for available flash drives on your ]
system. After you have selected the correct
flash disk drive, click OK.
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5.11.2 Card Data Management for Portable Disk

To use the card data stored on a flash disk, plug the flash disk into the USB port of any
computer. Using the My Computer directory of Microsoft Windows, locate the Flash Disk.

In the flash disk directory, locate the Card_MiniDrv folder. Double-click the
Card_MiniDrv folder. The following directory appears.

& Card MiniDry.

File Edt View Favortes Took Help Fo

Qo - () T Dsewen [orodes [

Address |2 CACard_MinDry

© Qe
R

-
A WiKernelob... WhCardMa... WMDILoad... WHDuet.DLL

File and Folder Tasks ' *
L

S} Rename this file :
B Meve this e
WhSean DLL  WMSystem.

) Copy this fle WMMAIN. .. WHMANAG.
& Fublish this file to the
weh

() E-mail this File ﬁ ﬁ

K Delete this file WMSystem_.. WMTRANS, .
v

Double-click on the WorldCard_M application as highlighted in the above. WorldCard
will display the MiniDrvWCard.wcf Read only mode as shown in the picture below.

W WorldCard --- MiniDrvWCard.wcf

Read only mode

Fie(E)  Help(H)

WorldCard

BB B -8 =9 ®HOB

= All Records.

[EM | Display Mame | Compary Office TEL 1 OFfice E-mail 1
= allRecords [ Steven Huang Microsoft Hong Kong Limited [852]804-420788
5 [ Business O Jackie Lai Businesscard hd +BB6(3]572-2897 jackis@penpowe|
03 American O Toshiski Take... W CO., LTD [0480)727-678
O Gamy Tan COMPLMN/ARE +B5-226-1776H. .. gan-tan@compuy
3 MATTHEW | .. Law OFFICES OF ANN KDO[408}452-8338
5 Lii MintaResearch (HK) Lid. 23909592 teteuo-seto@pal
< | >

In the Mini_Drv mode you can view cards in List or Label mode. You can use World-
Card search functions and send email using the same procedures as the standard WorldCard
database in the office. For instructions on using any of these available features, see the previ-
ous sections of this manual for complete operational instructions.
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Chapter 6 Scan Manager

WordCard integrates with Microsoft Outlook, Microsoft Outlook Express, Windows
Contacts (Vista) and ACT!. You can scan business cards and save verified contacts into the
above programs directly. You can view the original scanned business card image in Micro-
soft Outlook and ACT! as well.

6.1 Scanning Contacts

After installation, you’ll see the Scan Manager icon at the lower right corner on your
taskbar. Click it and select the desired software: Microsoft Outlook, Outlook Express, Win-

dows Contacts or ACT!. Whenever you click the software, WorldCard opens the scan wizard
of the indicated program.

Scan to Microsaft Outiook Scan to ACT! by Sage X)
Scan to Microsaft Outiook Express b o |

fort Side
Scan to ACT! SeRo Language

Close @ single Q Double-

ack Side

Fiench

Chinese character option

—Scanner Panel

Cafbratcn
Shipback side Soan
Fieszarn o side:

Auta recognion sfter scanning
Advanzed ediing
O uto scamning

Fiecogries contactio
aidiess book

Close

Note: Microsoft Windows Vista version Scan to Microsoft Outlook
supports scanning contacts into 2“" :D :rc":”""‘ Contacts
Microsoft Outlook and Windows C::ED :
Contacts.

Note: If your computer has installed ACT!, after installing WorldCard, you will see the

button in ACT!, you may also find WorldCard/ACT! under the Tool menu. Click
the button or WorldCard/ACT! from the Tool menu to start the Scan Wizard.
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WorldCard

%% ACTI by Sage - test

]EIe Edit View Lookup Contacts Gi Companies Schedule Write Reports | Tools | Help
=R RO

] 4 4 90of9 Contact List 2 té‘@ & | spelling...

0N Contact Detail Define Fields...

DesignLayouts 3
@ Company lmr\d(am—_l Addre Manage Users...
Contact [Fomce k. Borgedalen | .| Password Policy..

salutation IHWEE— Database Maintenance v

PR

Contacts

Title IW City Conyert ACT! 3.0 - 6.0 Items... —;[
e (NP B bomrersre—
: Phone W_I e[ Post: Copy/Move Contact Data...
Companies Mobile _| count Update Salutation Field... —_[_

‘_’ Fax 5 Timer shift+F4
ID/status - Web £ Synchronise »

Calendar

Referred By = E-ma Synchronigation Panel.

Handheld Setug...

Task List Notes | History | Activites | Oppertunities | Groups/Companies | Secondary Cont o 1| Heme Aderess
?"2 Dates: |al Dates - &selactuse(s g} R
Date 7| Time Regarding b (& [R N
Oppertunity | | 6 8 Customise ,
st Preferences..

5 WorldCard > ACT!

6.2 Scan business cards

6.2.1 Scan and Edit business cards

1. Insert a business card and click the Scan button to scan it.

Tip: The WorldCard software will require you to calibrate the scanner when you use the
scanner for the first time. Whenever there is color difference after scanning the card,
you can calibrate the scanner by clicking Calibration.

2. Editing Recognition:

Language: Select the language of the business card.

Chinese character option: Select Traditional Chinese or Simplified Chinese for the out-

put characters. If the characters include Hong Kong characters, select Recognize Hong
Kong character.

—Languags Chinese character option g‘
® Single- O Double-
sided sided
ront Side ———— ack Side ——— Output char: @ Tradiional Chinese
Q) Simplified Chinese
~
T [ FRecognize Hong Kong characters

|£

oK Cancel
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Auto recognition after scanning: Sclect Auto recognition after scanning to recognize

contacts after scanning. If this option is not selected, you need to click Recognize content

to address book after scanning.

Advanced editing: Select Advanced editing to edit contact data before exporting them into

address book.

It is recommended that you select Advanced editing to edit contact data before exporting

contact data into address book. Regarding the editing functions, please refer to Chapter 4.

Field Editor

eld)
Name = John Dow
Psition 5 lesSection Manager

o Karsten
Tel ® 151008976600
Fan 1510)897-6606

Addess B 48520 Fremont Bivd Sute 610 Fremont, C4 84538

Emal B sales@penpaner net

Wi DERpOwer net

WebSte +

Because Microsoft Outlook Express
provides limited set of fields you may see
Card Information (Unmatched Field) on
the left pane of the Editing window. It lists
the contact data of unmatched fields. These
data will not export to the address book of
Outlook Express. You can click the field
name to replace the field that is unmatched.
Click Export to Address Book after con-
firming all data.

& S| ER | = 43 et ]

Kemel  Lang,

h .

John Dow saes secton Manager

48520 Fremort Bive, Suits 810, Frermont, CA 04538
TEL: 510-897-6600  FAX. 510-897-6808
sales@penpower.net

wuiw penpower.net

Card InformationUnmatch Field)

Company ls 3Com company
Clear Field

Capitalization

Mame L
Positian

Company

Department
Tel 3
Fax 3
Mobile:

Pager

E-mail i
Web Sike [
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Note: When using Scan to ACT!, you will be asked to input the User 1D, Password and
DB Path after clicking Recognize contact to address book in order to save the
contacts into ACT! properly.

Please enter account and password

Userlr Iusemame|

Fassword I [~ Save Password

DB Path [C\Documents and Seftinga'warly Documerta\ ACTACT for Wind Browser
oo

6.2.2 View business card image

You can view the image of the business card by just selecting the exported contact from
your address book in Microsoft Outlook, and right-click to select view attachment. You can
magnify the image of the business card.

\E;yaw‘

e Edit View Go Tools NOD32 Actions Help

Type 3 question forhelp v

mew - | @133 X 4 % | HE W | [ searchaddressbosks  ~ | @ M |
Contacts « |53 A Joh - #iEE To-Do Bar » X
Blanconactiems  + ||[Glick here to ensble nstant Searcn [« somuomzs  »
My Contacts D - 15 SM TW T F S
L John Dow | | [RONDA CARLSON wessech..| | [Wang, Micher 123
S EEA Full Name: Joh Full Mame: RO, Full Name: Mica) -2 456
Current View 2 Job Title: Sale., Job Title: T Job Title: Ma..| | B 11 12 Brﬁ\ 15 16 17
© Business Cards , .
DOev s ohn Dow - C _ = x
© Adres orts cusnest (i) 1
© Detailed Address Cards || | Business Contact | st FormatTen @
O Ppnone List it | b Il sove s - [EGeneral] 84 certtiates | B, [82], % ) § B Y & y
O oy Categary —_— € Send - $Details Al Fields ED i a == @
O By Company | swen Email Meeting Call Business Picture Categorize Follow ¢ | Speling
- LealPan| “Cioe X Delete 53 Activiies Y =it ¥ i
© Outtony outa s Fut e Actions show Communicate Options Prosting
Company ull Name. lohn Dow
AddNew Group rner (Faame., ] [lohn | Zoe
Custonize Cunent View... | | Business  Company: ] g les Secton Manager
sales@penpower.net
BUSINgSt  ije ag: [ornbow 4]
Busines] 2652 Fremont Hvd. Site 610
Business Intemet Fremont, CA 94538
wipenpowecinet
E-mail [ e-mait -] [sees@oenponernet
vvvvv B RecordShow ot
3 wai jq Q &=
- 73406E706803.wrf
[] Tasks
nlica =
15 Items

John DOW Saies Secion Manager

48520 Fremont Bivd, Suite 610, Fremort,
660

TEL:

caoasss
3

Note: If WorldCard exports business card images into a user defined field of ACT!, you
may configure the settings of ACT! to view the images.

Note: WorldCard does not support viewing business card images in Microsoft Outlook

Express and Windows Contacts (Vista).



FAQ

FAQ

Q: How can I convert the files in earlier version to v6.X format?

A: WorldCard v6.x can convert your v5.x version files and import them in v6.x format. (For
v3.0, v4.0 CRD format, support is not available at this moment.) On the File menu, click
Import and then WorldCard file to convert the files to v6.x format. You can also use the
Start-Up Wizard to accomplish this task.

Q: Why are there dark lines on the scanned pictures of business cards, or all scanned
pictures turn out blank?

A: Before you use WorldCard the first time, you’ll be asked to complete Calibration. If the
problem still exists after calibrating, on the Tool menu, click Calibrate the scanner to
proceed with calibration. You can also use Calibrate the scanner in the scan wizard for
calibration.

Q

: How do I backup business card files?

A: On the File menu, click Export and click WorldCard files (v6.0 or later) to back up
files.

Q: How can I protect my business card files from being opened by other persons with-
out my permission?
A: On the File menu, click File encryption to encrypt files. Other persons have to type in
your predefined password to open the encrypted files.

Q

: How do I combine two pieces of business card data into one?

A: Hold down CTRL and click the left mouse button to select two single-sided business card
picture files or the image-less data of the card. Then right-click, click Combine, and set
either one to be the front side of the data combined.

Q: How do I separate a single picture file with data including the business card infor-
mation of front and rear sides into two separate data files?

A: Select the data including the business card information of front and rear sides, right-click,
then click UnMerge.

=)

: How do I add the signature information in e-mails to the business card files?

A: Select the signature or business card information in e-mail or a Word file. Then drag it
directly to the main Card window to finish.



CE Conformity and FCC Statement

q3

This equipment has been tested and found to comply with the limits of the European
Council Directive on the approximation of the member states relating to electromagnetic
compatibility according to EN 55022/55024 Part 15 B.

S

This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential energy and, if not
installed and used in accordance with the instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur
in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or more of the following measures:

¢ Reorient the receiving antenna
¢ Increase the separation between the equipment and receiver
¢ Move the computer away from the receiver

¢ Connect the equipment into an outlet on a circuit different from that to which the receiver

is connected
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